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1 About Alp

1.1 General Program Description

Alp (Analysis of Laterally Loaded Piles) is a program that predicts the pressures, horizontal
movements, shear forces and bending moments induced in a pile when subjected to lateral loads,
bending moments and imposed soil displacements.

The pile is modelled as a series of elastic beam elements.  The soil is modelled as a series of non
interactive, non-linear "Winkler type" springs.  The soil load-deflection behaviour can be modelled
either assuming an Elastic-Plastic behaviour, or by specifying or generating load-deflection (i.e. P-Y)
data.  Two stiffness matrices relating nodal forces to displacements are developed.  One represents
the pile in bending and the other represents the soil.  

1.2 Program Features

The main features of the problem analysed by Alp are summarised below and represented
diagrammatically.

The geometry of the pile is specified by a number of nodes, which may be specified directly by
the user or generated automatically based on the elevation of soil boundaries, loads, restraints
and displacements.
The positions of these nodes are expressed in terms of reduced level.  Pile stiffness is constant
between nodes, but may change at nodes.  Three methods of modelling the soil are available.

1. Elastic-Plastic
2. Specified P-Y curves
3. Generated P-Y curves

Elastic-Plastic 

The program generates the load deflection behaviour at each node from the soil data, see Elastic-
Plastic soil model.  Soil strata are horizontal and their boundaries occur midway between node
levels.

P-Y 

The user may specify the load deflection behaviour directly in the form of specified load-deflection
points (P-Y). The program linearly interpolates between these points.  If P-Y data is to be 
generated, then the appropriate method for Generated P-Y Curves is used for each soil.
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Applied lateral loads, bending moments and soil displacements are applied at nodes. To
obtain the deflection behaviour of the pile, an option is provided which enables these loads and/or
soil displacements to be applied in a specified number of increments.
Restraints acting at nodes with both an axial and rotational stiffness can be specified.
Water pressures can be specified and may be either 'hydrostatic' or 'piezometric' (i.e. non-
hydrostatic). This option is not applicable to the specified P-Y curves.
Surcharges may be specified at any level.  This option is not applicable to the specified P-Y
curves.
Partial Factors may be applied to both loads and soil strength parameters.

1.2.1 Sample Files

Sample files are provided during the installation process. These demonstrate Alp's features. By
default they are installed in the folder 'C:\Program Files\Oasys\Alp n\Samples', where n indicates the
version of the program. These files may be opened and inspected in Alp in order to become familiar
with the typical input data that is required to create an Alp model.

File Name Brief Description

Alp_Elastic-plastic.alw Example file having Elastic-plastic soil model

Alp_Specified_P-Y.alw Example file having Specified P-y Curves soil model

Alp_Generated_P-Y.alw Example file having Generated P-y Curves soil model
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1.3 Components of the User Interface

The principal components of Alp's user interface are the Gateway, Table Views, Graphical Output,
Tabular Output, toolbars, menus and input dialogs.  Some of these are illustrated below.

1.3.1 Working with the Gateway

The Gateway gives access to all the data that is available for setting up an Alp model. 

Top level categories can be expanded by clicking on the `+´ symbol beside the name or by double
clicking on the name. Clicking on the `-´ symbol or double clicking on the name when expanded will
close up the item. A branch in the view is fully expanded when the items have no symbol beside
them. 

Double clicking on an item will open the appropriate table view or dialog for data input. The greyed
out items in the gateway are disabled.

1.3.2 Preferences

The Preferences dialog is accessible by choosing Tools | Preferences from the program's menu.  It
allows user to modify settings such as numeric format for output, show welcome screen, option for
new model wizard, print parameters and company information. These choices are stored in the
computer's registry and are therefore associated with the program rather than the data file.  All data
files will adopt the same choices.
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Numeric Format controls the output of numerical data in the Tabular Output. The Tabular Output
presents input data and results in a variety of numeric formats, the format being selected to suit the
data.  Engineering, Decimal, and Scientific formats are supported.  The numbers of significant
figures or decimal places, and the smallest value distinguished from zero, may be set by the user.  

Restore Defaults resets the Numeric Format specifications to program defaults.

A time interval may be set to save data files automatically.  Automatic saving can be disabled if
required by clearing the "Save file.." check box.

Show Welcome Screen enables or disables the display of the Welcome Screen.  The Welcome
Screen will appear on program start-up, and give the option for the user to create a new file, to open
an existing file by browsing, or to open a recently used file.

Begin new files using New Model Wizard It gives an option to the user to create a new file using
new model wizard. For more details click here.
  
Company info The company information button in the preferences dialog box allows external
companies to specify the bitmap and Company name that they would like to appear the top of the
printed output.
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To add a bitmap enter the full path of the file.  The bitmap will appear fitted into a space
approximately 4cm by 1cm.  The aspect ratio will be maintained. 
Note! For internal Arup versions of the program the bitmap option is not available.

Page Setup Opens the Page Setup dialog allowing the style of output  for printed text  and graphics
to be selected. 
If 'Calculation Sheet  Layout´ is  selected  the  page  is  formatted  as  a  calculation  sheet  with  details
inserted in the page header. If `Logo´ is  selected the company logo is  inserted in the top left  corner
of  the  page.  If  `Border´  is  selected  this  gives  a  border  but  no  header  information.  If  `Clipped´  is
selected the output is clipped leaving a space for the logo. This has no effect on text output. 
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2 Step by Step Guide

The following provides a comprehensive guide through the menu options to help new users to the 
Alp.  The requirements for data input are listed and linked to relevant sections of the main manual.

Please read the Data Input sections before attempting to create a new file. 

Follow the New Model Wizard options to create the data file to ensure that the basic settings for a
model are correct before any data is generated, and to ensure that sufficient data has been supplied
in order to perform an analysis with minimum input data.

If not using New Model Wizard, then follow the below steps to create the data file.
 

No Operation Link From Program
Menu

From Gateway
(Double click on
below Gateway
item)

1 On the Start-up screen select the
option to "Create a new data file".

Opening the Program File | New        --

2 Add the general file information into
the Titles view. 

Titles Data | Titles Input | Titles

3 Select the required Units for data
entry and presentation of the
calculations using the Global Data |
Units option.  The frequency of
automatic file saving can also be set
here.

Units Data | Units Input | Units

4 Select the soil model, load,
displacement increment,number of
increments and load cases.

General Data Data | General
Data

Input | General
Data

5 Where applicable, enter partial factor
set to be used in analysis.

Partial Factors Data | Partial
Factors

Input | Partial
Factors

6 Enter data for sections to be used. Sections Data | Sections Input | Sections
7 Enter node levels and pile

properties. 
Pile Properties Data | Node

Levels
Input | Node
levels

8 Enter soil data for the selected type
of soil model.

Soil Data Data | Soil Data Input | Soil data

9 Enter the ground water data.(if any) Groundwater Data |
Groundwater

Input |
Groundwater

10 Enter applied loads and soil
displacements at any node.

Applied Loads and Soil
Displacements

Data |  App.
Loads and Disp.

Input | Applied
loads and
displacements.

11 Enter restraints for the nodes. Restraints Data |
Restraints

Input |
Restraints

12 Enter surcharges (if any). Surcharges Data |
Surcharges

Input |
Surcharges

13 Enter control data for convergence. Convergence Control
Parameters

Data |
Convergence
Control

Input |
Convergence
control

14 Now Analyse the data, warning/ error
messages are shown when the data
is not consistent.

Analysis Analysis |
Analyse

      --

15 After analysis the print selection
dialog will be displayed if successful.
Click OK to open Tabular Output to
output the input data and results.

Tabular Output View | Tabular
Output

Output | Tabular
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16 The graphical output shows a
graphical representation of the pile
and it's cross-section and the
displacement,  pressure,bending
moment and shear force diagrams.

Graphical Output View | Graphical
Output

Output |
Graphical
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3 Step by Step Example

This guide provides a beginner's introduction to the use of Alp for the analysis of laterally loaded
piles.  

A sample file is created and analysis is performed. The various stages of its data input are
illustrated. 

3.1 Creating the File and Setting the Units

Open Alp and create a new model by clicking the “New” button, or click “File” on the program's menu
and select “New”.  The main screen will open and the program automatically creates an "empty" set
of data. 

All the project identification data should be entered in the Titles dialog. The data entered here is
reproduced in the title block at the head of all printed information for the calculations, so it is useful
to provide enough details about the project.  

The user can specify the units for entering the data and reporting the results via the Units dialog.

This dialog can be accessed via Data | Units and via the Gateway. The user can set each base unit

individually or switch between various standard sets of units. The standard sets provided are SI,  kN-
m, kip-ft and kip-in. For this example kN-m is used.
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Note : If  "Begin new files using the New Model Wizard" option is checked in the Preferences dialog
(accessible via Tools | Preferences), the New Model wizard will open when new file is created. The
New Model Wizard contains only basic data which is required for creation of a file. The New Model
Wizard is not used in this example.

3.2 General Data Information

All general data, i.e. the type of soil model selected, the load case and the number of load and
displacement increments are input via the “General Data” dialog. This dialog is accessible via Data |
General Data from the program's menu or from the Gateway.

There are three soil models available. The Soil Data table view displays the input parameters that are
appropriate to the type of soil model that is chosen.

“Elastic-plastic” is the soil model that is most commonly used, and is the soil model used in this
example.Other sample files are available illustrating the use of other soil models.
“Factor on soil E value” is a reduction factor on the Young’s Modulus of the soil.  The default value is
0.8. This default is used for this example. 

The “Number of Increments” indicates the number of steps in which the specified load and/or
displacement is applied.  If the user is only interested in the results after the whole load and/or
displacement has been applied, this can be left at the default value of 1.  

The user must then select whether it is the load to be applied in increments and/or the soil deflection
to be increased in increments, using the radio buttons.  In this example the default selection, (Loads
Only) is used.

Note: If only loads or displacements are incremented then the others act to the full value throughout
the analysis.

The "Input" option allow the user to choose between inputting data by level or by node.  Using the
level based option the user defines the level of the loads, soil boundaries, displacements and
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restraints, and Alp then generates a set of nodes to be used in the final analysis.  Using the node
based option to user explicitly specifies the level of each node to be used in the analysis.  If
selecting input by level, the user must set the pile toe level using the text box provided here.  For
this example set the toe level to -4m.

"Node Generation Control Parameters" can be used to ensure limit both the total number of nodes
and the maximum variation in node spacings.

The user can use the check-box to activate partial factors.  Checking the box will make the partial
factors dialog visible in the gateway, and also shows options for partial factors in the soil (drained
and undrained) and load tables (to differentiate between permanent and variable loads, and favorable
and unfavorable loads).

The "Section Wizard Options" allow the user to set the concrete design code (this dictates the
available options for concrete mix, and associated Young's Modulus) and the bending axis, where
the user is using the wizard to generate pile width and EI values.

3.3 Convergence Data

Default values are provided by the program for the convergence parameters. The user can modify
them. 

This dialog can be accessed via Data | Convergence control or via the Gateway.

For this example the default values are used.
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3.4 Partial Factors

The partial factor dialog box can be used to apply partial factors to soil strength and loads.  Three
standard partial factor sets are included as a default (SLS, BS EN 1997-1:2004 DA1 C1 and DA1
C2) these can be selected but not modified by the user.  Additional partial factor sets can be created
by the user by typing the name into the drop down box, inputting factors into the relevant text boxes
(input 1 where no factor is required) and then clicking "Add".  User specified partial factor sets can
be modified by selecting the partial factor set to be modified using the drop down box, amending the
name and factors as required then clicking on "Modify".  Partial factor sets created or modified by
the user are saved by the application, and will be available when creating or editing other models in
the future.

To apply a partial factor set to the model, select the required set using the drop down box and click
"Apply".

Note: If changing the name and/or factors it is necessary to click on the "Modify" or "Add" buttons
to save the new partial factor set before clicking "Apply" to use the set in the model.
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3.5 Soil Data

The parameters in this table view are governed by the soil model selected in the General Data dialog.
This is accessible via Data | General Data or via the Gateway.

The example considered here has two different soil layers, the first layer runs from 8.5m to 4.5m and
the second layer runs from 4.5m to depth.  For both these layers the program is requested to
calculate the Kq and Kc values; Hence the "Calculated" option is selected for "Passive Res Coeffs".
If the user wants to enter the Kq and Kc values then the option to be selected is "User spec".

Note: if the user has selected input by node, then Top Node will be shown in column A.  The soil
surface is assumed to be midway between the top node given in the table, and the node immediately
above. Where the user specifies the uppermost node as the top node, the ground surface is
assumed to be level with the node.

3.6 Sections

Sections to be used in the pile are specified in the "Section Properties" table.  For each section that
the user wishes to create they must type in a section name.  The input type is then selected using
the drop down list, "Explicit" allows the user to directly specify the pile width and EI values to be
used in the model, "Generated" opens up a section wizard that calculates the width and EI values.

Two sections are used in this example, as shown in the figure.
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3.7 Pile Properties

The pile properties page allows the user to specify the top level of the pile and the level of any
change in section.  If the user selects the input "by node" option in the General Data dialog box the
location of each node forming the pile can be input directly, this also allows the user to input the
node levels using the Node Level table.

It is usual for 15-30 nodes to be used in an analysis.

Input by Level

To input the pile location by level enter the elevation at the top of the pile in column A, and select the
section type in the table.
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Input by Node

Where the user has selected the "By node" method for input, the level of each node, and the pile
section below each node is input via the Node Levels table view. This input can be given in tabular
form. The changes made to either of the forms are reflected in the other.

3.8 Groundwater

There is no Groundwater data for the problem being considered here. If there is any groundwater data
then it should be input in the groundwater table which can be accessed by Data | Groundwater or via
the Gateway.
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3.9 Applied Loads and Displacements

Loads, moments and lateral soil displacements at a node/level can be specified via the Applied
Loads and Displacements table. This is accessed via Data | Applied loads and displacements from
the program's menu or via the Gateway.

A lateral load of 200 kN is applied at a level of 8 m for this problem.  

Note : Positive loads act from right to left. Positive moments are clockwise.

3.10 Restraints

Lateral and Rotational stiffness can be specified at any node/level via the Restraints table. This is
accessible via Data | Restraints or via the Gateway.

In this example a high rotational stiffness of 900000 kN/m is applied to the top of the pile (10m) in
order to fix the node.
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3.11 Surcharges

Surcharges can be provided at any level within or on the soil. The surcharges table is accessible via 
Data | Surcharges or via the Gateway.

The example considered here has a surcharge of 15 kN/m 2 at a level of 8 m.

3.12 Analysis and Results

The model is now ready to be analysed.  Click the Analyse button (  ) on the Alp toolbar or
choose “Analysis” on the menu bar and select “Analyse”. The “Solution Progress” window will
appear.  Alp will automatically check the data for input errors. If no errors are found, “Checking data:
OK” will appear in the top left corner of the window. 
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If errors are found, Alp will not allow the analysis to proceed until they are corrected.  To run the
analysis click “Proceed”.

Once the analysis has completed the tabular output window will appear.  This will contain the
information about deflection, rotation, bending moment and shear at each node. All input data can
also be presented in the tabular output 

Click on the Wizard button (  ) to select which data and results are to be shown in the tabular
output. 
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To view the graphical output, click the Graphical Output button (  ) or click “View” in the menu

bar and select “Graphical Output”.

Different results can be shown on the graphical output using the buttons on the graphics toolbar,
such as:

    deflection

   rotation

   pressure

   bending moment

   shear
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If the number of increments specified in the General Data dialog is more than one, the user can view

the output for each increment by switching between next increment (  ) and previous increment (

 ) buttons on the Graphics toolbar. The number of increments for this example is only one.
Hence the increment buttons are deactivated.

It is possible to zoom in to areas of the graphical output by left clicking and dragging a square over
the area you wish to view.
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Clicking on the “Set Scale” button (  ) allows the user to change the scale at which the output is
displayed. The “User defined” radio button allows the precise scale to be specified.
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4 Method of Analysis

4.1 General

The numerical representation of the problem analysed by Alp is shown below.

The pile is modelled as a series of elastic beam elements joined at the nodes.  The soil is modelled
as a series of non-interactive non-linear "Winkler type" springs connected at the nodes.  Only 
horizontal forces can be transmitted between the soil and the nodes, and these forces are directly
related to the earth pressures.

The analysis comprises the following steps:

1. The stiffness matrices representing the soil and the pile are assembled.  In the P-Y model,
the maximum spring stiffness is used.

2. These matrices are combined, together with any stiffnesses representing the action of struts,
to form the overall stiffness matrix.

For each applied load or displacement increment:
3. If there are applied soil displacements, the program calculates the load corrections.  These

load corrections are the loads applied to each soil spring such that the soil, in the absence of
the pile, moves the specified amount.

4. The incremental nodal displacements are calculated from the nodal forces acting on the
overall stiffness matrix assuming linear elastic behaviour.

5. The change in earth pressure from that of the previous load increment is found by multiplying
the incremental nodal displacements by the soil stiffness matrix (and subtracting the load
corrections if appropriate).

6. The earth pressures are compared with the soil load displacement behaviour.  If the passive
limit is infringed, in the elastic plastic model a set of nodal correction forces is calculated.  In
the P-Y method the passive limit is set to the appropriate displacement (Y).  These forces are
used to restore earth pressures to within the strength limits.  A new set of nodal forces is
then calculated.

7. Steps (3) to (6) are repeated until convergence is achieved.
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8. Total nodal displacements, earth pressures, strut forces and pile shear forces and bending
moments are calculated.

4.1.1 Elastic-Plastic Soil Model

The load displacement curve assumed for the elastic-plastic soil model is shown below.

The elastic spring constant is calculated from the expression:

K = (EhE
f act

) kN/m

where:

E = Young's modulus of the soil
h = distance between the midpoint of the

elements immediately above and below the
node under consideration

E
f act

= factor generally taken between about 0.6 and
1.0 (see Broms (1972) and Poulos (1971)).

A typical value of E
f act

 for clay is 0.8.   It is recommended that users read the relevant references.

The soil stiffness matrix contains the values of K at each node along the diagonal with all other
terms equal to zero.

The passive limiting force (Fp) is calculated from the following expression:

Fp = (K
q

'  + cK
c
)hD

where:

K
q

= Passive resistance coefficient for the frictional
component of the soil.

' = Vertical effective stress at the node under
consideration.

K
c

= Passive resistance coefficient for the cohesive
component of the soil

c = Cohesion.
h = Distance between the midpoints of the

elements immediately above and below the
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node under consideration.
D = Pile diameter.

Passive Resistance Coefficients (Tomlinson, 1986) 

Values of Kq established by Brinch Hansen (1961) 

Values of Kc established by Brinch Hansen (1961) 

For a cohesionless soil K
q
 can be taken = 3*K

p
 where K

p
 is the Rankine coefficient of passive

pressure.  This was the value adopted by Broms (1964).

The vertical effective stress ( '
v
) at a node at level z is calculated as:

where:
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= Unit weight of a stratum
z

s
= Surface level

u = Prescribed pore pressure

su
= Sum of the vertical pressures of all

surcharges above the level z

Factors for calculating coefficient of modulus variation (nh) for cohesionless soil (after

Tomlinson,1981)

Relative density Loose Medium
dense

Dense

n
h

 for dry or moist soil 

(Terzaghi, 1955)

MN/m³ tons/
ft³

2.5 7 7.5 21 20 56

n
h
 for submerged soil 

(Terzaghi, 1955)

MN/m³ tons/
ft³

1.4 4 5 14 12 34

n
h
 for submerged soil 

(Reese et al, 1956)

MN/m³ tons/
ft³

5.3 15 16.3 46 34 94

Other observed values of n
h
 are as follows:

Soft normally-consolidating clays: 350 to 700kN/m³ (1 to 2 tons/ft³).
Soft organic silts: 150kN/m³ (0.5 tons/ft³).

E
f act

 = n
h
.z/E   where z = depth

4.1.2 P-Y Soil Model

A P-Y curve represents the lateral load-deflection behaviour of a discrete layer of soil.  This is
achieved either by the specification of points that define a piece-wise linear curve: 

or by the specification of the equation that describes the curve.  

The curve is independent  of the shape and stiffness of the pile.  The curves used for each of the
three soil model types are described below.
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4.1.2.1 Specified P-Y Curves

The user may specify the P-Y data to represent the load deflection of the soil.

The load and corresponding deflection is input at each node to provide a vertical profile of behaviour
down the side of the pile.

4.1.2.2 Generated P-Y Curves

Lateral soil resistance deflection (P-Y) curves may be constructed for 'Soft clay', 'Stiff clay', and
'Sand' strata for both 'Static' and 'Cyclic' load cases as detailed below:

Soft

P-Y curves for soft clay are calculated using the method established by Matlock (1970).

The ultimate resistance (P
u
) of Soft clay increases from 3cu to 9cu as the depth X increases from 0

to X
R
 according to:

Pu = For X  X
R   

  (1)

Pu = 9c
u
D For X  X

R
    (2)

Pu = ultimate soil resistance per unit length

c
u

= undrained shear strength

'
u

= vertical effective stress

D = pile diameter
J = dimensionless empirical constant (0.5 for Soft

clays)
X = depth below soil surface
X

R
= depth below soil surface to bottom of reduced

resistance zone 

If cu is constant with depth, equations (1) and (2) are solved simultaneously to give:

(3)

If cu varies with depth, equations (1) and (2) are both solved at each depth, until equation (2) is less

than equation (1) to give X
R
.

The P-Y curve for short-term 'Static ' load cases is then generated for the following points:

P/Pu Y/Yc

0 0
0.29 0.2
0.50 1.0
0.72 3.0
1.00 8.0
1.00 (2.5D)

where:

P = Soil resistance per unit length
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Y = Lateral deflection
Yc = 2.5 x E50 x D
E50 = Strain at one-half the maximum stress for an

undrained triaxial compression test.

P-Y curve for Soft Clay (Static) 

If no direct laboratory data is available suggested values of E50 for Soft to Firm clays are as follows
(after Sullivan et al, 1980):

Consistency E50
Soft 0.020
Firm 0.010

The P-Y curves for the 'Cyclic ' case are generated from the following points:

P/Pu X XR Y/Yc P/Pu X<XR Y/Yc

0 0 0 0
0.29 0.2 0.29 0.2
0.50 1.0 0.50 1.0
0.72 3.0 0.72 3.0
0.72  (2.5D) 0.72X/X

R
15.0

0.72X/X
R

(2.5 D)

P-Y curve for Soft Clay (Cyclic) 
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Stiff Clay 

The API RP2A 18th Edition (1989) and 21st Edition (2000) recognise that stiff clays have important
non-linear stress strain relationships and are generally more brittle than soft clays. However, the API
references give no P-Y data. Alp therefore uses the following.

The ultimate soil resistance of stiff clay is calculated using equations (1) and (2) as before, but
assuming J = 0.25.

The P-Y curve for short-term 'Static' load cases is then generated for the following points; i.e. the
same values as for soft clay.

P/Pu Y/Yc

0 0
0.29 0.2
0.50 1.0
0.72 3.0
1.0 8.0
1.0 (2.5D)

        P-Y Curve for Stiff Clay (Static) 

If no laboratory data is available suggested values of E50 for stiff to hard clay are as follows (after
Sullivan et al, 1980):

Consistency E50
Stiff 0.005
Hard 0.004

The P-Y curves for 'Cyclic' are generated for the following points:

P/PU X XR Y/YC P/PU X<XR Y/YC

0 0 0 0
0.29 0.2 0.29 0.2
0.50 1.0 0.5 1.0
0.72 3.0 0.72X/XR 15.0
0.72 (2.5D) 0.72X/XR  (2.5D)
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P-Y Curve for Stiff Clay (Cyclic) 

Sand

Two choices of P-Y curve for sand are available: 

Reese et al (1974); and
API RP2A 21st edition (2000).

Descriptions of the two methods are given below.

Reese et al (1974)

If the Reese et al has been selected, then the P-Y curves for sand are calculated using the method
established by Reese et al. (1974).

The ultimate resistance of sand varies from a value determined by equation (4) at shallow depths to a
value determined by equation (5) at deep depths.  The depth of transition (Xt) is determined by
comparing the value of each equation at the specified depths.

The ultimate resistance of sand at shallow depths is determined according to:

Equation 4 

(4)

and the ultimate resistance of sand at deep depths is determined according to:

Equation 5 

(5)

Pu = ultimate resistance per unit length
A = Empirical adjustment factor which accounts for differences in static and cyclic behaviour (see

Reese et al, 1974)
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' = effective vertical overburden pressure 

X = depth below soil surface 
K

0
= coefficient of earth pressure at rest

= angle of internal friction of sand 
= 45 + '/2
= '/2

D = pile diameter 
K

a
= Rankine minimum active earth pressure coefficient [tan²(45 - '/2)]

The lateral soil resistance-deflection (P-Y) relationship for sand is non-linear and is represented by a
four-segment curve.  If Y

k
> Y

m
, point 2 is omitted and the curve becomes linear between (0,0) and

(Y
k

 > P
m

).

P-Y Curve for Sand (Static/Cyclic) 

The values of points u, m and k are computed as follows:

u: Pu = Equation 4 at depths  X
t

Equation 5 at depths  X
t

Yu = 3D/80

m: Pm = (B/A)Pu

Ym = (1/60)D

wher
e

B = Non-dimensional empirical adjustment factor to account for difference in static and cyclic
behaviour (see Reese et al, 1974).

k: P
k

= (X/D)K
1
Y

k

Y
k

=

wher
e

N =

k
1

= Initial soil modulus
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The P-Y curve between points k and m is a parabola with intermediate points calculated from:

The following values of k1 for submerged sand are typical for static and cyclic loading (Reese et al,
1974).

Relative Density k1 (MN/m2/m)

Loose 5.43
Medium 16.29
Dense 33.93

API RP2A 21st Edition (2000)

If the API 21st Edition has been selected, then the P-Y curves for sand are calculated as described
below.

The ultimate lateral bearing capacity for sand at shallow depths is calculated as:

pus = (C
1
 x H + C

2
 x D) x  x H

The ultimate lateral bearing capacity for sand at deep depths is calculated as:

p
ud

 = C
3
 x D x  x H

where:

p
u

= ultimate resistance (force/unit length), kN/m (s = shallow, d = deep)

= effective soil weight, kN/m3

H = depth (m)
C

1
,

C
2
, C

3

= coefficients determined from Figure 6.8.6-1 of the API RP2A 21st Edition

D = average pile diameter from surface to depth (m)

The lateral soil resistance-deflection (p-y) relationship is described by:

where:

P = actual lateral resistance (kN/m)
A = factor to account for cyclic or static loading conditions (0.9 for cyclic loading, max(3.0 - 0.8H/

D, 0.9) for static loading
k = initial modulus of subgrade reaction (kN/m3) determined from Figure 6.8.7-1of the API RP2A

21st Edition
y = lateral deflection (m)
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Weak Rock

                         P-Y Curve for Weak Rock 

P-Y curves for weak rock are calculated using the method established by Reese (1997).
The ultimate resistance (p

ur
) of weak rock increases as the depth x

r
 increases from 0 to 3b

according to:

 p
ur = For 0  x

r 
 3b

 
  (1) 

 p
ur

= For x
r
  3b    (2)

 p
ur

= ultimate soil resistance per unit length

r = strength reduction factor

urq = compressive strength of rock

 b = pile diameter
 x

r
= depth below rock surface

The lateral soil resistance-deflection (P-Y) relationship for weak rock is represented by a three-
segment curve.  The relationship is described by:
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where,

 K
ir =  k

ir
E

ir

 
k

ir
= For 0  x

r 
 3b

  (1) 

 k
ir

= dimensionless
constant

= 500 For x
r
  3b    (2)

 y
rm

= k
rm

b

 
y

A
=

  
lateral deflection of
Pile at point A       

=

k
rm

= dimensionless constant ranging from 0.0005 to 0.00005, that serves to
establish overall stiffness of p-y curves

E
ir

= initial modulus of rock

             Six points representing the P-Y Curve for Weak Rock 

In the program, the curve is represented as a series of straight lines formed between the following six
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points:

First Point ( y
1 

 )     =  0 (origin)

Second Point ( y
2 

 )     =  y
A

Third Point ( y
3 

 )     =  y
2 

+( ( y
6 

-
  
y

2 
) / 4 )

Fourth Point ( y
4 

 )     =  y
3
+( ( y

6 
-
  
y

2 
) / 4 )

Fifth Point ( y
5 

 )     =  y
4 

+( ( y
6 

-
  
y

2 
) / 4 )

Sixth Point ( y
6 

 )     =  16*y
rm

Strong Rock

P-Y curves for strong rock are calculated using the method published by Turner (2006).
The ultimate resistance (P

ult
) of strong rock is given by the expression:

  P
ult =

  b = pile diameter

 us = half of the compressive strength of the rock

The lateral soil resistance-deflection (P-Y) relationship for strong rock is represented by two linear
segments.

4.1.3 Pile Stiffness

The pile is modelled as a series of elastic beam elements, the stiffness matrix being derived using
conventional methods from slope deflection equations.  

Considering a single beam element of length L and flexural rigidity EI spanning between nodes A and
B, the moments (M) and forces (P) at nodes A and B can be expressed as functions of the
deflections and rotation at the nodes, i.e.
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where A, B and A, B represent the deflections and rotations at nodes A and B respectively

referred to the neutral axis of the beam.  The above equations can be rewritten in matrix form as:

[M] = [A][ ] + [B] [ ]

and

[P] = [C][ ] + [A]T[ ]

where [A], [B] and [C] are functions of the element lengths and flexural rigidity (EI), and [ ] and [ ]

are the nodal horizontal displacements and rotations.

If there are no moments applied to the pile, [ ] can be eliminated to give

[P] = [S][ ]

in which [S] is the pile stiffness matrix given by

[S] = [C] - [A]T[B]-1[A]

4.1.4 Applied Lateral Loads and Displacements

Lateral Loads 

Lateral loads can be applied in the form of horizontal forces and bending moments.  The forces can
be defined explicitly or in the form of soil displacements.

Lateral loads and bending moments can be applied at any node.  The applied loading moment loads
[M] are converted into a series of lateral loads

[P] = [M][A]T[B]-1.  

Soil Displacements 

Soil displacements can be specified at any node.  Between nodes when soil displacements are
specified the program calculates an applied displacement using linear interpolation.  Above the
highest node and below the lowest node the respective value is assumed to be constant.

Increments 

The program allows for the loads and soil displacements to be applied in increments.  This can be
done in the following combinations;

loads only
displacements only
or both loads and displacements.
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If both loads and displacements are incremented both are applied gradually.  If only one is
incremented the other is kept constant at the full value.

4.1.5 Restraints

Restraints with a specified axial and rotational stiffness can be specified at any node.  The additional
stiffness supplied to the pile by restraints is catered for in the program by adding the moment
stiffness to the diagonal of matrix [B] described in Pile stiffness and by adding the lateral stiffness to
the relevant position on the diagonal of the overall stiffness matrix.

4.1.6 Partial Factors

Partial factors can be set by the user to adjust the loads and soil strength parameters.

Load Factors

The load (L) used in the analysis is calculated from the design load (Ld) input by the user, using the
relevant partial factor (γ

L
) that can vary for permanent/variable and favourable/unfavourable loads.

L = Ld x γ
L

Soil Strength Factors

The design soil parameters are modified as shown below.

The unit weight (W) used in the analysis is calculated from the design unit weight (Wd) input by the
user, using the relevant partial factor (γ) such that 

W = Wd/γ

The drained cohesion (C') used in the analysis is calculated from the design drained cohesion (C'd)
input by the user, using the relevant partial factor (γ

c'
) such that 

C' = C'd/γ
c'

The undrained shear strength (Cu) used in the analysis is calculated from the design undrained
shear strength (Cud) input by the user, using the relevant partial factor (γ

c
) such that 

Cu = Cud/γ
c

The shear angle (φ) used in the analysis is calculated from the design shear angle (φd) input by the
user, using the relevant partial factor (γ

φ
) such that 

φ = tan-1(tan(φd)/γ
φ
)

The ultimate compressive strength of rock (Qur) used in the analysis is calculated from the design
ultimate compressive strength (Qurd), using the undrained shear strength partial factor (γ

c
) such

that 

Qur = Qurd/γ
c



Part V
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5 Input Data

5.1 Assembling Data

It is best to make a sketch of the problem before the computer is approached.  This should
comprise a cross section of the proposed pile with the:

ground surface
location of each soil strata
calculation method
parameters of each material
phreatic surface
location of any piezometers
location and magnitude of applied lateral loads, bending moments or soil displacements
location of any restraints
level of any vertical surcharges.

5.1.1 Opening the program

On selection of the Alp program the main screen will open.

This is the main screen within which all further data, graphics and results are entered and viewed. 
All further information appears in the smaller window, which is placed inside the main background
screen.  

To start a new project file select :

File | New or 

the new file icon .  
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This will open a new Titles window and allow you to proceed.  It is possible to open more than one
data file at any one time.  The file name is therefore displayed in the title bar at the top of each child
window.

5.1.1.1 Intranet link and e-mails

To view the latest information regarding the Alp program or contact the support team click on the

internet  or support team  buttons on the Start screen or select the options from the
toolbar.  

Note!  Once in the program the Start screen can be re-accessed using Help | Show startup window.

List of information required and actions before contacting support team:  

Version of Alp (see top bar of program or Help | About Alp)
Spec of machine being used.
Type of operating system.
Please pre-check all input data.
Access help file for information.
Check web site for current information.
Should you report a program malfunction then please attempt to repeat and record process prior
to informing the team.

The web site aims to remain up to date with all data regarding the program and available versions. 
Should any malfunctions persist then the work around or fix will be posted on the web site.

5.1.1.2 New Model Wizard

If the program preferences have been set appropriately then the New Model Wizard is accessed by
selecting the `File | New´(Ctrl+N) option from the main menu, or by clicking the 'New' button on the 
Alp toolbar. Cancelling at any time will result in an empty document. 
The New Model Wizard provides a quick and easy method of the inputting a simple model that is
sufficiently complete to perform an analysis. Additional more complex or detailed data may be added
to the model once the New Model Wizard is completed. 

5.1.1.2.1  New  Model Wizard : Titles and Units

The first property page of the New Model Wizard is the Titles and Units window. This allows the user
to enter the job details. By default the job details of the previous job are used. 
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Job Number 
This is the job number, which can be any alphanumeric string. By clicking the drop-down button,
the user can access the job numbers recently used.

Initials 
The initials of the user used on printed output. 

Job Title 
The title of the job. 

Subtitle 
The subtitle that this model relates to. 

Calc Heading 
Specific to this model. 

The above items are reproduced in the title block at the head of all printed information for the
calculations. The fields should therefore be used to provide as many details as possible to identify
the individual calculation runs. 
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An additional field for Notes has also been included to allow the entry of a detailed description of
the calculation. This is reproduced at the start of the data output.

Units 
It is possible for user to enter the preferred units before entering the input data by clicking the
Units button.

5.1.1.2.2  New  Model Wizard : General Data

The general data is  entered to define the outline of the problem and  type  of  analysis  to  be  carried
out.
Only the Elastic-plastic soil model is available through the New model wizard.

The  user  can  also  choose  to  set  a  number  of  options  for  the  model  including  the  application  of
increments, to input data by  node or level,  and whether or not  to use partial factors.   These dictate
the available options when the initial model is  created,  and can be amended  subsequently  through
the main General Data dialog. 
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5.1.1.2.3  New  Model Wizard : Pile and Soil Data

Pile data,   soil  data,  applied  load,  soil  displacement,  ground  water  data  is  entered  through  this
page.
Nodes and Pile properties are generated automatically  by  clicking the Finish button after entering
data.
Only a single soil layer and single pile with a constant diameter and properties is generated.
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5.1.2 Titles

The first window to appear, for entry of data into Alp, is the Titles window. This view also accessible
via Data | Titles from the program's menu.  

This window allows entry of identification data for each program file.  The following fields are
available:

Job Number allows entry of an identifying job number.
Initials for entry of the users initials.
Date this field is set by the program at the date the file is saved.
Job Title allows a single line for entry of the job title.
Subtitle allows a single line of additional job or calculation

information.
Calculation Heading this allows a single line for the main calculation heading.

The titles are reproduced in the title block at the head of all printed information for the calculations. 
The fields should therefore be used to provide as many details as possible to identify the individual
calculation runs.

An additional field for notes has also been included to allow the entry of a detailed description of the
calculation.  This can be reproduced at the start of the data output by selection of notes using File |
Print Selection, see the contents list for information on File Handling.

5.1.2.1 Titles window - Bitmaps

The box to the left of the Titles window can be used to display a picture beside the file titles.  To add
a picture place an image on to the clipboard.  This must be in a RGB (Red/Green/Blue) Bitmap
format.  Select the Paste Bitmap button to place the image in the box. 

The image is purely for use as a prompt on screen and can not be copied into the output data.  Care
should be taken not to copy large bitmaps, which can dramatically increase the size of the file.



Alp

Copyright © O as ys  2000–2017 53

To remove a Bitmap select the Remove Bitmap button.

5.2 Data Input

Data is input via the Data menu's options, or via the Gateway.

Once the data has been entered the program places a tick against that item in the menu list. 

5.2.1 Units

This option allows the user to specify the units for entering the data and reporting the results of the
calculations.
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Units 

Default options are the Système Internationale (SI) units - kN and m.  The drop down menus provide
alternative units with their respective conversion factors to metric.

Standard sets of units may be set by selecting any of the buttons: SI, kN-m, kip-ft kip-in.

Once the correct units have been selected then click 'OK' to continue.

SI units have been used as the default standard throughout this document.
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5.2.2 General Data

The following general data is entered to define the methods of solution.

Soil Model 

Three soil models are available:  

Elastic Plastic
Specified P-Y curves
Generated P-Y curves with static or cyclic load cases

Selection of the required type amends the Soil Data table to the correct parameters, see  Soil Data.

For the elastic-plastic model a factor on the E value, Efact, is required.  This factor is discussed in  
Elastic-Plastic soil model.  The default value is 0.8.

Loads and displacement increments 

Applied loading can be defined explicitly or in the form of soil displacements.  The actual values are
specified in tabular form, see Applied Loads and Soil Displacements.

The user must specify the number of increments required to reach the applied load or displacement
and then, if the number of increments is greater than one, whether the increments are applied to: 

'Applied Loads ONLY' or 
'Soil displacements ONLY' or
'Loads AND soil displacements'.

If only the loads or the displacements are incremented then the others act to the full value
throughout the analysis.

Input and Node Generation Control Parameters
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Data can be input by level, with a node set automatically generated.  Using this option the user can
directly specify the level of soil boundaries, loads, restraints and other features.  The program will
then automatically generate a set of nodes for the analysis.  If input by level is selected the user will
need to specify the pile toe level in the text box provided.

If the user chooses to input data by node, then the user can add each node explicitly. Loads and
restraints are then assigned directly to nodes, and soil boundaries to the mid point between nodes.

Note: if input by level is chosen, the user should check that the generated node set is appropriate
for the analysis.  It is possible to switch from input by level to input by node after the nodes have
been generated, and either add, delete or edit nodes.

Partial Factors

If partial factors are required, the partial factor option must be checked.  This will make the partial
factor dialog available, and also add partial factor options to the soil and load tables.

Section Wizard Options

If using the section wizard to generate pile section properties, these options can be used to select
which concrete design code and bending axis is considered by the wizard.  The concrete design
code is used to generate a list of concrete mixes specified by the code, and obtain the specified E
value to calculate the section stiffness.

5.2.3 Convergence Control Parameters

The following convergence controls are required.

Number of iterations 

The maximum number of iterations allowed by the user.  The default value is 300.

Displacement error 

The maximum displacement error in any one iteration.  This represents the maximum change of
displacement between successive iterations.  The absolute error in the result will be considerably
larger (typically by a factor of 10 to 100).  The default value is 0.001mm.
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Pressure error  

The maximum error in pressure (i.e. how much the pressure at any node is below the active limit or
in excess of the passive limit).  This is an absolute value and the default value is 0.1kN/m².

Damping Coefficient 

The damping coefficient used in the analysis.  If convergence is slow this can be increased.  If
instability is apparent it may possibly be solved by reducing this.  The default value is 1.0.

Incremental deflection 

Maximum deflection in one increment.  The default value is 2.0m.

Note!  Convergence control parameters may be varied from the default values offered to improve the
speed/accuracy of the solution, or to reduce the chance of numerical instability.

The program solution will iterate until the two tolerance conditions are satisfied, subject to the
specified maximum number of iterations not being exceeded.

5.2.4 Partial Factors

Partial factors dependent on the method and on material parameters can be specified. A default set
of partial factors is hard coded into the program and is not editable. This default set includes factors
recommended by:

Eurocode 7 Design Approach 1, combinations 1 and 2
SLS (all values = 1.0)

Method partial factors can be applied to:
favourable or unfavourable loads
soil unit weight
drained or undrained cohesion
soil friction angle

User-specified factors can be added and will then be stored in an XML file that is included in Alp - if a
data file containing user-defined values is sent to another user, the values will be extracted from the
data and saved to the second user's XML file.
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5.2.5 Soil Data

The table of input soil parameters is governed by the selection of soil model in the General Data, see
 General Data. Soil data can be entered in tabular form by selecting 'Soil Data' from the Data menu
or the Gateway.

Note! Stratum boundaries occur midway between the top node and the node immediately above it,
except when the top node coincides with the top of the pile.

5.2.5.1 Elastic-Plastic Data

Details of the elastic-plastic soil model are given in  Elastic-Plastic soil model.   The required data
entry is as follows:

Top Node or Top Level Top node (if input by node) or top level (if input by level) within this
stratum

E Young's modulus 
Unit Weight Bulk unit weight 
Passive Res. Coeffs. The user may input the soil friction (Phi) that is used to calculate the

Passive Resistance Coefficients as established by Brinch Hansen
(1961). Alternatively Kq and Kc can be overridden as per user's

choice.
Phi Internal soil friction phi can vary between 0.01 to 60 degrees
Kq Passive resistance coefficient for the frictional component of the soil

Kc Passive resistance coefficient for the cohesive component of the soil.

c(top) Cohesion 

dc/dz Rate of change of cohesion with depth 

If partial factors are active the user will also need to use the drop down menu to indicate whether the
analysis is drained or undrained for each stratum.
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5.2.5.2 Specified P-Y Data

If P-Y curves are specified for each node, the coordinates (P
n
, Y

n
) are input as follows:

User specified P-Y data at each node represents the load deflection behaviour of the soil to a
distance of half the element above and below the node.  The program assumes perfectly plastic
behaviour for values of displacement in excess of the final specified displacement.  A maximum of 6
specified points can be used with the first point being set at (0,0). 
 
For nodes above the soil surface only the first point (0,0) is specified.

The units for the P-Y curves are:

P = force/unit length of pile 
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Y = displacement 

5.2.5.3 Generated P-Y Data

Guidance on the choice of suitable curves for particular soils for both static and cyclic load cases is
given in Generated P-Y curves.

The loading type, 'static' or 'cyclic', must be specified in the General Data, see  General Data.  For
each soil layer the top node or top level must be specified, for input by node and input by level
settings respectively. Using the drop down menu, the soil must be defined as 'Soft clay', 'Stiff clay',
'Sand (API 18)', 'Sand (API 21)', 'Weak Rock' or 'Strong Rock' .

Note: Alp does not consider the loading type i.e. 'static' or 'cyclic' for soils defined as weak or strong
rocks.  

If either the 'Soft clay' or 'Stiff clay' option is selected, the following soil properties are required for
each stratum:

Unit weight Bulk unit weight 
E50 Strain at half the maximum stress for an undrained triaxial test, 

see  Generated P-Y curves
cu(top) Undrained shear strength at the top of the stratum

dcu/dz Rate of change of undrained shear strength with depth 

If the 'Sand (API 18)' or 'Sand (API 21)'  option is selected, the following soil properties are required
for each stratum:

Unit weight Bulk unit weight 
K0 Coefficient of earth pressure at rest

K1 Initial soil modulus (k1), see  Generated P-Y curves

Phi Angle of internal friction

If the 'Weak Rock' option is selected, the following soil properties are required for each stratum:
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Unit weight Bulk unit weight 
qur Compressive strength of rock

αr Strength reduction factor

krm Dimensionless constant, ranging from 0.0005 to
0.00005

Eir Initial modulus of rock

If the 'Strong Rock' option is selected, the following soil properties are required for each stratum:

Unit weight Bulk unit weight 
qur Compressive strength of rock

If partial factors are active the user will also need to use the drop down menu to indicate whether the
analysis is drained or undrained for each stratum.

5.2.6 Sections

A range of pile sections can be entered by the user, these define the effective width/diameter and the
flexural stiffness of the pile where the section is used.

Sections can either be entered explicity or generated using the section wizard.

5.2.6.1 Explicit

Using the explicit method the section details are entered directly into the section properties table.

Section Name
Enter a unique name for the section.

Input Type
Using the drop-down list select 'Explicit' to type in the pile parameters.

Effective Width
The effective width of the pile, i.e. the width perpendicular to the direction of loading.
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EI
The pile flexural stiffness is typed into the relevant column.

5.2.6.2 Generated

Using the generated method the section details are calculated using the section wizard.

Section Name
Enter a unique name for the section.

Input Type
Using the drop-down list select 'Generated' to type in the pile parameters.  This will automatically
open the section wizard.

Effective Width
The effective width of the pile, this box is non-editable for 'Generated' entries and shows the value
calculated by the wizard.

EI
The pile flexural stiffness is non-editable for 'Generated' entries and shows the value calculated by
the wizard.

Editing Existing Sections
To edit an existing section right click anywhere within the relevant row then select 'Wizard' from the
drop down menu.  Alternatively select a cell within the relevant row and click on the wizard button 

. This will reopen the section wizard.

5.2.6.2.1  Section Wizard

The section wizard contains a number of options to allow the user to define the pile section.  The
section wizard is a shared object used by several Oasys software programs.  Some of the options
used by other programs are not applicable to Alp and have been deactivated (including the
environmental attributes, modifiers, miscellaneous and compound section).  The available options
are summarised below.
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Member Type
The drop down box can be used to assign the type of section being used.  This defaults to 'Pile' and
it is recommended that this option is used.  The 'General' member type can also be selected.  This
allows a wider range of section profiles to be selected, however, it does not calculate an effective
width for the pile. 

Material Type
The drop down box can be used to select either a concrete or steel pile.

Material
The specific class of material is selected using the 'Material' drop down list.  For concrete the
available classes is affected by the design code selected in the general data dialog.

Profile
Clicking on the 'Profile' button opens up a series of pages that can be used to define the shape of
the pile.  Alternatively, where the user is familiar with the codes, they may wish to specify section
profiles directly by typing the shape code directly into the text box adjacent to the 'Profile' button.
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The 'Definition' page allows the user to select the general pile shape by clicking on the appropriate
radio button, then clicking 'Next'.  
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The shape section definition page allows the user to input the dimensions of the section.  The units
and solid/hollow section options are selected using the drop down boxes in the top left of the screen.
 The dimensions are then typed into the relevant boxes.  If the transform section option is checked
this will allow the user to rotate the section, e.g. for consideration of loads that are non perpendicular
to the principle axes.
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The final page of the profile wizard shows the parameters calculated for the section. Additional
options available include:

Convert to Perimeter - this stores and defines the shape as a series co-ordinates that mark the
external boundary.  This affects how the shape and described in the main page and consequently
how it can be modified subsequently by the user.
More - this shows further section properties calculated by the wizard.
Export - this option creates a table listing the section properties as a .dxf file.

Following the creation of the section profile the main window of the wizard is amended to show the
section profile and include the section description.
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The text in the section description can be amended to edit the section profile.  The format for codes
is listed in the shape codes section.  Where the user is familiar with the codes, they may wish to
specify section profiles directly by typing in the shape code.

Component Attributes
Reinforcement
Clicking on the 'Reinforcement' button opens up the main reinforcement dialog, that can be used to
add reinforcement bars to a concrete section.

Holes
Clicking on the 'Holes' button opens up the main holes dialog, that can be used to add holes to both
concrete and steel sections.

Properties
This button opens the properties dialog box.  This lists the properties calculated for the section
profile input by the user.
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5.2.6.2.1.1  Shape Codes

Shape codes can be used to explicitly define a section shape.  Codes for typical pile shapes are
listed below.

  

5.2.6.2.1.2  Reinforcement

Reinforcement is added to the generated section through the reinforcement dialog.

Reinforcement Settings

The 'Links', 'Cover' and 'Smeared Reinforcement' buttons, open up dialog boxes that allow the user to
set the default values for these options.
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Adding Reinforcement 

To create a new reinforcement set either double left click on <template> in the list to use the
reinforcement wizard.  Alternatively click on the 'Add' button or right click within the list box and
select 'Add' from the drop-down menu.

Using the reinforcement wizard, the user must first select the general arrangement for reinforcement,
and rebar material type from the 'Template Definition' Page.

The following page will vary dependent on the section shape and chosen reinforcement template. 
For the given general arrangement the user will be able to specify details, e.g. the bar size, number
of bars, bar type, etc.

Using the standard 'Add' option opens the 'General Reinforcement Definition' dialog, and allows the
user to specify reinforcement type and location explicitly.  Within the bar details options the user
can set the size, type and bundling of bars.  Within the bar position options, the user can set the
reinforcement bar locations.  Bars can either be specified individually by y and z co-ordinates, or in
an arrangement (including a line, arc, circle and perimeter) defined by the user.
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To create a new reinforcement set based on an existing set select the set to be used as a template,
and either click on the Clone button or use the copy and paste icons.

Editing Reinforcement

To edit an existing reinforcement entry, select the required entry in the list box then either click on
the 'Modify' button, or right click on the selected section and select 'Modify' from the drop-down
menu.  This will reopen the reinforcement wizard or general definition dialog used to create the entry.

Deleting Reinforcement

To delete reinforcement, select the required reinforcement entry from the list and either click on the

delete icon , or right click and select delete from the drop down menu.

5.2.6.2.1.3  Holes

Using the 'Section Component Hole Definition' dialog holes can be created within the section.  

Circular and square holes can be created, though the distinction between the two is primarily for the
graphical display as these are approximated as point areas within the model.  To alternate between
circular and square holes left click in the Shape column for the relevant entry.  The area of the hole
is then entered into the Area column and the location using the y and z coordinates.
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5.2.7 Pile Properties/Node Levels

The pile properties and node level pages are considered together as they present the same input
options and data.  When using the input by node setting the table is identical for both.  When using
the input by level setting, the pile properties table is used to input the level for the top of pile, base of
pile and any change in section and the corresponding section type.  In this setting the node levels
table is only accessible once nodes have been generated for the pile and shows the node levels for
user information only - these levels are not editable. 

The pile is modeled as a series of elastic beam elements.  The details of the which are given in  Pile
Stiffness.  The required input data is the pile section (which gives the pile diameter and bending
stiffness (EI)) and the level of nodes (which are generated automatically if the input by level setting is
used).  The diameter and bending stiffness can be varied along the length of the pile, at the positions
of nodes.

The values of diameter and flexural (bending) stiffness (EI) are assumed constant between nodes,
i.e. they change at the nodes.  For generating the P-Y curve coordinates at a node, the diameter
specified below the node is used in the calculations.

As well as defining changes in the pile properties, nodes are also required at:  

restraint levels
load, moment and displacement levels 
soil stratum boundaries, where these boundaries occur midway between nodes.  Note!  As a
special case the ground surface may coincide with the top node.

The calculated pressures, deflections, bending moments and shear forces are output only at node
positions.  Extra nodes are therefore required in order to model the flexibility of the pile and to obtain
a reasonably complete representation of the forces, pressures and bending moments.
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Data can be entered directly using the tables in both input by level and input by node settings.

Level Based Input

When inputting data by level, it is only necessary to define the top of the pile, the pile toe level (via
the General Data dialog box) and each point within the pile at which the section changes.  The level
at the top of pile and at each change in section must be typed into the level column in descending
order, and the corresponding section type selected from the drop-down box in the section type
column.  This is done through the pile properties option in the gateway.

To delete a pile section, left click on the entry you wish to delete in the pile section column.  Then
right click anywhere on that row and select 'Delete'.

To view the node levels click on the node level option in the gateway.  This table will show the node
levels generated by Alp, however, these levels cannot be modified by the user and the table can only
be accessed once nodes have been generated.

Node Based Input

When inputting data by node, each node is specified explicitly with the level and section type
entered into the table.  The level is entered in the level column and the section selected from the
drop-down box in the section type column.  Nodes must be entered in descending order, with the
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last entry representing the pile toe level.

A larger number of nodes will provide a more numerically accurate solution, but for most problems 20
to 30 should suffice.  

Note! To avoid numerical instability, it is recommended that the spacing between any two pairs of
nodes should not differ in length by more than a factor of two.

To delete a node, left click on the entry you wish to delete in the node column.  Then right click
anywhere on that row and select 'Delete'.

5.2.8 Groundwater

A single groundwater profile is entered to surround the pile.  This can be hydrostatic or piezometric.
Groundwater can be entered in tabular form by selecting 'Groundwater' from the Data menu or the
Gateway. 
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The data is entered in tabular form.  The points should be entered in order of increasing depth and
the first (or highest) point must specify zero water pressure.
This first line of the table allows a single value for the unit weight of water to be added. On
subsequent lines, levels and pressures can be entered to create a piezometric profile.  Interpolation
between the points is linear and the water profile beneath the lowest point is assumed to be
hydrostatic.

If only one data point is entered, the program will also assume a hydrostatic groundwater
distribution.  

For hydrostatic distributions the water pressure (u) is calculated from

u = zw w

where

zw = depth below water table level

w = specified unit weight of water

Thus a partial hydrostatic condition can be modelled by specifying a value of  w less than 10kN/m³.

For piezometric profiles the level and pressure at each known point must be entered.  If more than
one data point is entered, the program will assume that the points represent piezometers, and the
ground water pressure will be interpolated vertically between the specified points.  Below the lowest
point, groundwater pressure will be assumed to extend hydrostatically.  

5.2.9 Applied Loads and Soil Displacements

Lateral loads can be placed on the pile at nodes by specifying a load and moment.  The sign
convention for the loading is:  

Load - Positive to the left.
Moment - Positive clockwise.

Note! The sign convention has been changed from that in the DOS program prior to Version 2.3. 
Old Alp data files will be converted automatically by the program to the new sign convention.
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The applied loads shown above act in the positive direction.  

Lateral soil movements, which would occur if no pile was present, can be specified at any node. 
As stated in  Applied Lateral Loads and Displacements, linear interpolation is used between
specified nodes and constant values of soil displacement are assessed outside of the node range
specified.  Loads and Displacements can be entered in tabular form by selecting 'Applied Loads and
Displacements' from the Data menu or the Gateway.

 

Node no The node number at which it acts
Force The applied lateral force, positive values indicate a force to the

left 
Moment The applied moment, positive values indicate a clockwise applied

moment 
Soil Displacement Lateral soil movements that would occur if there were no pile

present, positive values indicate soil movement to the RIGHT . 



Alp

Copyright © O as ys  2000–201776

 

Increments 

The user must specify the number of increments of applied load or displacement and then, if the
number of increments is greater than one, whether the increments are applied to the loads,
displacements or both.  This is done via the General data dialog box, see  General Data.

5.2.10 Restraints

Restraints can be applied to any node and given a combination of lateral and rotational stiffness.
Restraints can be entered in tabular form by selecting 'Restraints' from the Data menu or the
Gateway.

Note that the specification of a high rotational stiffness at Node 1 means that the pile is effectively
'fixed' at the top.  

5.2.11 Surcharges

Vertical surcharges within or on the soil are not confined to node locations and can be specified at
any level. Surcharges can be entered in tabular form by selecting 'Surcharges' from the Data menu
or the Gateway. 

A positive pressure acts vertically downwards. 

Note! This option has no effect for specified P-Y curves.



Part VI



Alp

Copyright © O as ys  2000–201778

6 Output

6.1 Analysis and Data Checking

Results can be obtained by selection of the Analysis menu.

Prior to analysis the program carries out a data check.  Warnings are provided should data errors be
located.

If no errors are found then the calculation can proceed.  Select Proceed.

Note:  The option to Examine results becomes available once the calculations have been completed.

6.2 Tabular Output

Tabular Output is available from the View menu, the Gateway or the Alp Toolbar. This output may
include input data and, if an analysis has been performed, results. The lists of tabulated output can
be highlighted and then copied to the clipboard and pasted into most Windows type applications e.g.
Word or Excel. The output can also be directly exported to various text or HTML formats by
selecting Export from the File menu.

The Tabular Output provide a listing of displacements, bending moments and shear forces at each
node.   An indication is given in the output to show if the passive soil pressure limit is exceeded. The
letter "p" next to a result indicates that the effective earth pressure is greater than 0.99 times the
passive limit, but within the convergence pressure limit.

The selection of information that is required is made via the 'Print Selection' dialog.  This dialog is
presented upon selecting the Output View.
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The 'Results' option is available only if the data has been successfully analysed.

 The maximum and minimum deflections, bending moments and shear forces are reported with a
summary of the convergence errors.
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6.3 Graphical Output

To obtain a plot of data and results, select 'Graphical Output' from the 'View' menu, the Gateway or
the Alp Toolbar.

For information on the use of the Toolbar and Status bar functions please see the Index list.

Input data is always shown, and individual result types can be switched on or off as required using
the buttons on the graphics toolbar.
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The Graphics menu will be
available when Graphical Output
view is activated.

 

6.3.1 Set Exact Scale

Selection of  Set Exact Scale icon  allows you to set any required scale for the graphics.  This
is done using the following data entry screen,

which allows best fit, specified or engineering scales.  The X and Y scales can also be changed to
give different values and distort the drawing



Part VII
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7 Programming Interface

Programming interface is provided by COM Automation  in Alp
 

COM Automation allows commands to be issued from a separate process via a set of VBA or C++
instructions. The separate process could be a separate program or, indeed, a VBA script in a
spreadsheet.
 

7.1 COM Automation

COM Automation allows other programs to access to Alp 19.2 operations by creating an instance of
Alp class "alpauto_19_2.Application" and calling the exported functions of this class. The available
COM export functions are listed below.
 

Note that function names are case sensitive.
 

More:
COM Export Functions
COM VBA Example
COM C++ Example

7.1.1 COM Export Functions

The Alp COM export functions are listed below:
 

The use of many of these functions is demonstrated in sample Excel (XLS) files that are installed in
the Samples folder in the Alp program folder. The return code (short data type) for all these functions
is zero on successful execution, and -1 on failure.  Where a value has a '*' prefix, it indicates that it
is a value modified by the function providing an output.

 

 short NewFile()
 

Open a new model. 
 

short Open (string filename)
 

Open a *.alw file. 
 

filename – the name of the file to be opened, including path and extension.
 

short Save ()
 

Save the data to the default file (i.e. overwriting the file that was opened or last saved).
 

short SaveAs (string filename)
 

Save the data to*.alw file. 
 

filename – the name of the file to be saved, including path and extension.

short ReadTextFile (string filename)
 

This sets all data in the current document to be equal to that set by a text file.  A
template and example '.txt' file are included with the installation demonstrating the
required format for any files to be imported.

filename – the name of the '.txt' file to be imported, including path and extension.
 

short Close ()
 

Close the current file.  
 



Alp

Copyright © O as ys  2000–201784

short Analyse ()
 

Analyse the current file.
 

short Delete ()
 

Deletes the results in the current file.
 

short Show ()
 

Show the running instance of Alp created by the Automation client. 
  

short UpdateVIews ()
 

Refreshes all the Alp views currently displayed. 

 

short MaxDisp (double* dMaxDisp)
 

Gets the maximum displacement of the pile.
 

short GetNumNodes (short* sNumNodes)
 

Gets the number of nodes in the current files. 
  

short GetNodeLevel (short sIndex, double* dLevel)
 

Gets the level of the node identified by sIndex .
 

short GetNodeEI ((short sIndex, double* dEI)
 

Gets the EI value of the pile at the node identified by sIndex.
 

short GetNodeDia (short sIndex, double* dDia)
 

Gets the pile diameter at the node identified by sIndex. 
  

short GetNodeDisp (short sIndex, double* dDisp) 

Gets the pile displacement at the node identified by sIndex. 
 

short GetNodeShear (short sIndex, BOOL Below, double* dShear)
 

Gets the pile shear at the node identified by sIndex. If the BOOL value is TRUE, the
function returns the shear just below the node, otherwise it returns the shear just above
the node.

  

short GetNodeBM (short sIndex, double* dBM)
 

Gets the pile bending moment at the node identified by sIndex.
 

short GetNodeRotation (short sIndex, double* dRot)
 

Gets the pile rotation at the node identified by sIndex. 
  

short GetNumSoils (short* sNumSoils) 

Gets the number of soil layers considered in the model, note this is the number of soil
layers, not the number of materials. 

 

short GetSoilLevel (short sIndex, double* dLevel)
 

Gets the top level of the soil layer specified by sIndex, with the indexing going from 1 for
the top soil layer and increasing with depth.

  

short GetToeLevel (double* dToeLevel)
 

Gets the pile toe level.
 

short GetLoadIncs (short* sIncs)
 

Gets the number of load increments if using increments on loads only.
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short ExportCSV (string filename)
 

Exports the text output of results to the either a csv file. The file path and extension
should be specified in the filename variable.

short ExportCSVResult (string filename, short sType, short iInc)
 

This function exports a csv table from the current file.  The string filename needs to
specify the full file path, name and extension.  sType indicates which result to export
and can have the following values - 0 for the bending moment profile with depth, 1 for the
shear profile with depth and 2 the displacement profile with depth.   sInc indicates the
load increment for which the results are required.  

short ExportCSVPushOver (string filename)
 

This function exports a csv table from the current file showing the pushover curve for the
top node (i.e. the lateral load v displacement for the top node for the number of
increments analysed).  The string filename needs to specify the full file path, name and
extension.

short SetGlobalSoilFactor (double* dSoilFactor)
 

Sets the global factor on soil E value.

short SetEforSoil (short sIndex, double* dE_Soil)
 

Sets the Young's modulus for soil specified by index sIndex.

short SetRefCohesionforSoil (short sIndex, double* dCoh_Soil)
 

Sets the reference cohesion for soil specified by index sIndex.

short SetPhiforSoil (short sIndex, double* dPhi_Soil)
 

Sets the internal friction angle for soil specified by index sIndex.

short SetCohesionGradientforSoil (short sIndex, double* dCohGrad_Soil)
 

Sets the cohesion gradient for soil specified by index sIndex.

short SetNodeLoad (short sIndex, double* dForce, double* dMoment,
double* dAppDisp)
 

Sets the load for a node specified by index sIndex, with dForce, dMoment and
dAppDisp representing the lateral load, moment and applied displacement
respectively.

short SetNodeLoadAndType (short sIndex, double* dForce, double*
dMoment, double* dAppDisp, short* IsFav, short* IsLive)
 

Sets the load for a node specified by index sIndex, with dForce, dMoment and
dAppDisp representing the lateral load, moment and applied displacement
respectively.  The short IsFav is used to indicate whether the load is favourable or
unfavourable - with 1 indicating unfavourable and 2 indicating favourable.  The
short IsLive indicates whether it is a dead (1) or live (2) load.

short SetDia (double dDia)
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Sets the diameter of the pile.

short SetToeLevel (double dToeLevel)
 

Sets the toe level of the pile, and regenerates nodes based on the new toe level.

short ClearNodes ()
 

Deletes all nodes from the currently selected file provided that the file is sent to
specify by node, for files set to input by level this function will return a fail.

short ClearSpecPY()
 

Deletes all specified PY curves from the currently selected file provided that the
soils mode is set to specified PY, for other modes the function will return a fail.

short AddNode (double dLevel, short iSection)
 

This function adds a new node to the current file, with dLevel setting the level of
the new node, and iSection providing a reference to the correct section for the
diameter and stiffness.  Note that nodes must be added in descending order, and
that there must be a section corresponding to the reference.

short AddNodePY (double dP1, double dY1, double dP2, double dY2, double
dP3, double dY3, double dP4, double dY4, double dP5, double dY5, double
dP6, double dY6)
 

This function adds a new specified PY point to the file, with dP1 corresponding to
P1, dP2 corresponding to Y1, etc.  As with the AddNode function this points must
be added in descending order corresponding to the node levels.

short SetNodePY (short iNode, double dP1, double dY1, double dP2, double
dY2, double dP3, double dY3, double dP4, double dY4, double dP5, double
dY5, double dP6, double dY6)
 

This function is similar to the AddNodePY function, however instead of adding a
new PY curve it overwrites an existing curve for the node referenced by iNode.  If
no curve has been specified for the node this function will return a fail.

7.1.2 COM VBA Example

The following is an example VBA script to run Alp remotely. This script can be found in the Excel file
in the Samples folder shipped with the program.
 

Sub TestAlpCOM()

Dim AlpObj

Set AlpObj = CreateObject("alpauto_19_2.Application")

Dim AlpFilePath As String

Dim ExportFilePath As String

Dim sResult As Integer

Dim rFileName As Range
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Dim sFileName As Range

    With Worksheets("Alp Auto")

        Set rFileName = .Cells(3, 3)

        Set sFileName = .Cells(4, 3)

    End With

AlpFilePath = rFileName.Text

ExportFilePath = sFileName.Text

AlpObj.Open AlpFilePath, sResult

'Delete existing results

AlpObj.Delete sResult

'Add test load into Alp file

Dim sForce As Double

Dim sMoment As Double

Dim sAppDisp As Double

sNode = 1

sForce = 10000# 'Units are in SI

sMoment = 5000# 'Units are in SI

sAppDisp = 0#   'Units are in SI

AlpObj.SetNodeLoad sNode, sForce, sMoment, sAppDisp

'Perform Analysis

AlpObj.Analyse sResult

'Save file

AlpObj.SaveAs AlpFilePath, sResult

'Export to CSV

AlpObj.Export ExportFilePath, sResult

Set AlpObj = Nothing

End Sub

7.1.3 COM C++ Example

The following is an example C++ code to run Alp remotely.

 

bool RunOneFunction(
COleDispatchDriver* pDispDriver,
CString csFuncName,
BYTE* pArgType,
CString csArgument,
SHORT* pShort)

{
DISPID dispid;
OLECHAR* pcsFunc;
CString csMsg;
int iReturn(0);
pcsFunc = csFuncName.AllocSysString();
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//Find the function ID
if(pDispDriver->m_lpDispatch->GetIDsOfNames(

IID_NULL,
&pcsFunc, 
1, 
NULL, 
&dispid) != S_OK)

{
csMsg.Format(_T("Function (%s) cannot be found"),csFuncName);
AfxMessageBox(csMsg);
return false;

}

//Run the function
if(csArgument.IsEmpty())

pDispDriver->InvokeHelper(
dispid,
DISPATCH_METHOD,
VT_I2,
&iReturn,
pArgType,
pShort);

else
pDispDriver->InvokeHelper(
dispid,
DISPATCH_METHOD,
VT_I2,
&iReturn,
pArgType,
csArgument,
pShort);

if(iReturn != 0)
return false;

else
return true;

}

void RunAlp()
{

CoInitialize(NULL);

COleDispatchDriver cAlpDispDriver;

BYTE pArgType1[] = VTS_WBSTR VTS_PI2;
BYTE pArgType2[] = VTS_PI2;
CString csPath1("D:\\Tests\\Alp\\Auto\\Test.alw");//Replace this with

the correct path and file location
CString csPath2("D:\\Tests\\Alp\\Auto\\TestCopy2.alw");//Replace this

with the correct path and file location

// Create an instance of the Alp class "Alp.Automation"
if(!cAlpDispDriver.CreateDispatch(_T("alpauto_19_2.Application")))
{

AfxMessageBox(
_T("Alp not found or not registered"));
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return;
}

bool bStat(true);
SHORT sRet;
// Function Open
if(bStat)

bStat = RunOneFunction(&cAlpDispDriver,
_T("Open"),
pArgType1,
csPath1, &sRet);

// Function Save
if(bStat)

bStat = RunOneFunction(&cAlpDispDriver,
_T("Save"),
pArgType2,
_T(""),
&sRet);

// Function SaveAs
if(bStat)

bStat = RunOneFunction(&cAlpDispDriver,
_T("SaveAs"),
pArgType1,
csPath2,
&sRet);

// Function Close
if(bStat)

bStat = RunOneFunction(&cAlpDispDriver,
_T("Close"),
pArgType2,
_T(""),
&sRet);

cAlpDispDriver.ReleaseDispatch();

CoUninitialize();
}



Part VIII
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9 Alp

9.1 Brief Technical Description

Alp (Analysis of Laterally Loaded Piles) is a program that predicts the pressures, horizontal
movements, shear forces and bending moments induced in a pile when subjected to lateral loads,
bending moments and imposed soil displacements.

The pile is modelled as a series of elastic beam elements.  The soil is modelled as a series of non-
interactive, non-linear "Winkler type" springs.  The soil load-deflection behaviour, can be modelled
either assuming an elastic plastic behaviour, or by specifying or generating load-deflection (i.e. P-Y)
data.  Two stiffness matrices relating nodal forces to displacements are developed.  One represents
the pile in bending and the other represents the soil.
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